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About the Presenter:
Craig Escudé, MD, FAAFP
►

Board-Certified Fellow of the American
Academy of Family Physicians

►

Over 20 years of experience caring for people
with mental illness and intellectual and
developmental disabilities

►

Medical Director of Hudspeth Regional Center
in Whitfield, MS – Retired 2018

►

Founder and Clinical Director of DETECT

►

President of HRS, Inc.

My Journey
►
►
►
►
►
►
►
►
►

Upbringing
Introduction of new ideas
Questioning
Doubting
Learning
Experiencing
New views
Teaching
Creating the new norm
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QUESTIONS
What are the top preventable causes of
death in people with IDD?
► How can you distinguish between medical
and mental conditions in people with
IDD?
► How can you facilitate the best healthcare
visit for people with IDD?
►

WHAT ARE THE TOP
PREVENTABLE CAUSES
OF DEATH IN PEOPLE
WITH IDD?

Bowel Obstruction
Blocking of movement through the
GI tract from scar tissue, lack of
movement (peristalsis) or
constipation or foreign body
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Bowel Obstruction
►

Major cause of death in the community

►

Inability to communicate pain or other symptoms

►

Over-reliance on bowel management medications

►

Influence of anti-cholinergic drugs

►

Failure to implement early intervention

►

Risk of repeat incidents is VERY high!

The GI Tract
It is impacted by…EVERYTHING
►
►
►
►
►

Medications
Stress
Physiology
Position
Nutrition/hydration

Peristalsis
Primary peristaltic wave: Esophagus
►

Stomach stores food, mixes it up with
digestive juices and empties contents
slowly into the small intestine

►

Finally, all digested nutrients absorbed
through intestinal walls

►

Undigested products propelled into
colon, and remain for a day or two, until
expelled as a bowel movement.
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Constipation
Primary cause of “everything”
►

Fever

Anorexia
Vomiting
► Seizures
► Medication Intoxication
► Decreased LOC
► Pneumonia
► Behavioral outbursts
► Death

►

►

Constipation - Causes
►
►
►
►
►

Decreased GI motility
Immobility
Lack of sensation
Diet
Medications
►
►
►
►
►

►

Anti-Epileptic Drugs
Antipsychotics
Iron
Anti-cholinergics
Opiates

Pica
►
►

Common
May cause bowel obstruction

Constipation - Treatment
► Diet
►
►

Fiber
Adequate fluid intake

► Laxatives
MOM
Mg Citrate
► Polyethylene glycol
►
►

► Suppositories
► Enemas
► Manual

dis-impaction
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Dietary Issues
►

Not enough fiber

►

Not enough fluid

►

Not enough movement

For high fiber recipes
see the “handout”
section of the control
panel

Prevention
1.

Avoid use of irritant laxatives

2.

Provide adequate fluid - 8 oz. for every 6-7 g a day

3.

Increase dietary fiber gradually - 6-8 g every 2
weeks

4.

Give time and attention to periods of high gut motility

5.

Increase physical activity

6.

Supplement gut flora with yogurt, or pro-biotics with
6 to7 billion organisms per capsule

7.

Uncooked, high-fiber fruits and vegetables at each
meal

Aspiration
Breathing food or
fluid into the airway
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Aspiration
►

A high cause of death in people with IDD

►

Influenced by many factors

►

Individual management and staff training are
critical!

►

Identifying root cause is vital!

►

Can be caused by food going in or out of the
stomach

Anatomy of the
Head and Neck
Nasopharynx

Tongue

Oropharynx
Epiglottis
Esophagus
Trachea

Anatomy of the
Head and Neck
Nasopharynx

Tongue

Oropharynx
Epiglottis
Esophagus
Trachea
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Aspiration in Sitting

Aspiration in
hyperextension

Aspiration during intake due
to poor tongue mobility and
positioning in reclined sitting

Aspiration
►

Acute
Large quantity of aspirated material

►

Smaller quantity

►

Recurrent

►

►

►

►
►

Can result in death
Pneumonia
Frequent pneumonia
Wheezing

Aspiration – Subtle Signs and
Symptoms
►

Cough - especially with feeding

►

Refusal to drink thin liquids

►

Resistance in eating or drinking

►

Recurrent pneumonia

►

Reactive airway disease
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Aspiration - Causes
►
►

Constipation
GERD
►
►

Reclined positioning
Liquid diet

Dysphagia
GI dysmotility
► Sedation
►
►

►
►

Medications
Illness

Aspiration - Prevention
► Positioning
► Feeding techniques
► Feeding evaluation
►
►

► Test

Thickening Liquids
Food texture/size

- Modified barium swallow

► PEG Tube
► Volume/Time
► J-Tube
► J-Tube/PEG

Getting in trouble
with swallowing
Aspiration is about swallowing only 25%
of the time!
Look at the following
Before it goes down?
As it goes down?
► Does it go down?
► Does it get out of the stomach?
► Does it come out the other end?
►
►
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Gastroesophageal
Reflux disease (GERD)
Back flow of partially digested
food and acid into the esophagus
causing pain and inflammation

Gastroesophageal
Reflux disease (GERD)
Multiple causes of death
Massive GI bleed
Esophageal cancer
► Aspiration of stomach contents
►
►

Common Signs Not Recognized
►
►
►
►
►
►
►

Pica
Hands in mouth
Agitation within 30 minutes of eating
Refusing meals
Agitation and restlessness in the middle of
the night
Clinical signs: eroding hemoglobin,
hematocrit and albumin (blood protein)
Unplanned weight loss regardless of intake
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Diagnosis
PH monitor
Barium Swallow
► Endoscopy
► Oxygen Saturation decreasing at any
time during or after mealtime
►
►
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Seizures
An alteration in brain function
resulting in changes in awareness, or
function for a brief period of time

Seizures
►

Can be most severe and difficult to treat

►

Varying presentations

►

Status epilepticus prevalent
►

►

Sub-clinical status - rapid eye movements

Accurate seizure record VERY helpful in
management
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Seizures
Status epilepticus
► Respiratory
► SUDEP

suppression

- Sudden Unexplained

Death in Epilepsy

Seizures – Precipitating Factors
►
►
►
►
►
►

Constipation
Infection
Medication compliance issues
Menses
Age
Shunt issues
►

►
►
►
►

May see change in LOC

Head Injury
Stroke
Hypoglycemia
Electrolyte Imbalance

Seizures
Drug toxicity
AED’s – always one of the top 10 most
dangerous drugs
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Seizures
Seizure sequelae
►

Aspiration

►

Accidents

Seizures – What to do
►
►
►
►
►
►
►

Ease the person to the floor.
Turn the person gently onto one side. This will help the
person breathe.
Clear the area around the person of anything hard or
sharp. This can prevent injury.
Put something soft and flat, like a folded jacket, under
his or her head.
Remove eyeglasses.
Loosen ties or anything around the neck that may
make it hard to breathe.
Time the seizure. Call 911 if the seizure lasts longer
than 5 minutes. Follow your program’s guidelines.

Audience Question…
Would you say that you have a basic
understanding of what “Sepsis” is?
►

Yes

►

No
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Sepsis
Blood poisoning due to
failure of the immune system
to respond to infection.

Sepsis
Also known as Blood Poisoning
Caused by an infection or its toxin spreading
through the bloodstream
► Occurs when large numbers of infections agents
invade the bloodstream leading to bacteremia
► Initial infection often comes from:
►
►

►
►
►

Burn, ulcer or open wound
Pneumonia
Urinary Tract Infection (UTI)

Sepsis is a Silent Killer
►

A “silent killer” whose early diagnosis could
save thousands of lives each year

►

Should be treated aggressively

►

Very prevalent, costly disease with a high
in-hospital mortality rate
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Sepsis Signs and Symptoms
►
►
►
►
►
►

High temperature
Rapid pulse
Chills
Low blood pressure
Mottling of the skin
Confusion and lightheadedness

Audience Question…
Have you ever lost a person that you
support or in your family from sepsis?
►

Yes

►

No

Every hour that passes without
treatment raises death risk by 10%
When in doubt, send them out!
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Dehydration
►
►

►
►
►
►

Vomiting
Limited intake
► Limited ability to communicate thirst
► Immobility to access fluids
► Loss during intake
► Medical conditions – DM
► Staff awareness
Dysphagia
Drooling
If PEG Tube – inadequate amount of fluids
provided
Draining PEG- Excess fluid loss without
replacement
► Follow electrolytes

Recap
► Bowel

Obstruction

► Aspiration
► GERD
► Seizures
► Sepsis
►+

Dehydration

Remember…

When in doubt, send them out!
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Questions?

HOW CAN YOU DISTINGUISH
BETWEEN MEDICAL AND
MENTAL CONDITIONS IN
PEOPLE WITH IDD?

IT AIN’T EASY!!
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Dual Diagnosis
► Two

conditions that occur together

► IDD
► Mental

Health Issue
use issues

► Substance

► Co-existence

of the symptoms of both
intellectual or developmental disabilities
and mental health problems

Prevalence of Dual Diagnosis
► Estimated

that 30-35% of all persons with
intellectual or developmental disabilities
have a psychiatric disorder
► Estimated 2/3 of people with IDD are on a
psychotropic medication.
► Treating behavior with psychotropic
medications

IDD
► Usually

born with it
of it from an early age
► Doesn’t get better
► Impacts all areas of functioning
► Evidence

► Communication

skills
interaction
► Activities of daily living
► Social
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How is IDD Diagnosed?
Standardized tests such as an IQ test are
used to determine a child’s level of intellectual
development.
► A score below 70 on a standardized IQ test
indicates that he may have intellectual
development disorder.
► One must also exhibit deficiencies in two or
more specific areas of adaptive behavior,
such as communication skills, interpersonal
skills, or daily living skills like getting dressed
and using the bathroom.
►

How are Mental Illnesses Diagnosed in
People Without IDD
► Evaluation

of symptoms expressed during
an interview
► Evaluation of social and functional
problems
► Lab testing
► Diagnostic testing
► Patient Health Questionaire-9
► Beck Depression Inventory
► Generalized Anxiety Disorder-7
► CAGE test for substance abuse

► DSM-5

Criteria

STATEMENT
Diagnosing Mental Illness in
People with IDD is
Complicated
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Evaluation by Observation
►
►
►
►
►
►
►
►
►

Eating sleeping and activities
Assess current environment
Activities
Expectations by others
Changes in living situations
Gains made by certain actions
Look at behaviors
What triggers the behaviors
What stops the behaviors

Go to the Experts

Involving direct caregivers in plan development
►
►
►
►
►
►
►

Staff often work closest to and spend most time
with people
Encourage contributions, observations,
hypotheses, ideas, intervention strategies
Staff can identify trends and missing puzzle pieces
that managers and behaviorists often cannot
Foster control and confidence
Promote participation and involvement in planning
Consider opinions and answer questions
Provide ongoing support and guidance

Best Practice Assessment:
Bio-psycho-social Model
1. Review Reports
2. Interview Family
3. Interview Care Provider
4. Direct Observation
5. Clinical Interview
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Behavior and Medical Issues
MUST ASSESS FOR MEDICAL PROBLEMS
► Downs
►Thyroid Disease-Depression
►Dementia
► Pain may result in challenging behaviors
► GERD can cause agitation and/or confusion
► Patterns to behavior? - PMS

Behaviors Associated with GI
Distress/Reflux
► Hand

mouthing

► Pica
► Food

refusal
when lying down
► Physical or verbal aggression
particularly around meal times
► Coughing

Behaviors Associated with
Head Pain
►
►
►
►
►
►
►
►

Head banging
Head butting
Hitting or slapping self
Inserting objects into ears or nose
Crying
Withdrawal from areas with light or noise
Sitting with head in lap
“Refusals” to listen or respond
(loss or reduction in hearing)

►
►

Hands over ears or face
Tilting head to one side
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Behaviors Associated with
Medication Side Effects
► Blinking

►Weight

► Medication

►Agitation

refusal
► Refusal to eat
► Urinary or fecal
incontinence
► Constipation
► Urinary retention
► Aggression
► Fatigue

gain or loss

►Scratching

self
change in
cognitive status
►Tics, dystonic
symptoms
►Muscle twitching
►Falls,

Behaviors associated with
Pneumonia
► Fatigue
► Withdrawal
► Refusal

to eat

► Falls
► Increased

irritability
in cognitive status
► Refusal to lie down to sleep
► Change

Behaviors Associated with
Dental Issues
► Hitting

self
in mouth
► Refusal to eat
► Spitting out food
► Physical or verbal aggression
particularly around meal times
► Hands
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Behaviors Associated with
Constipation
Guarding abdomen
Rocking
► Not able to sit still (up and down)
► Hitting self in abdomen
► Fetal position when lying
► Knees drawn up to chest when sitting
► Physical or verbal aggression without definite
antecedent
► Refusal to eat
►
►

Behaviors associated with
Seizures
►
►
►
►
►
►
►
►
►
►
►
►

Disrobing
Increased agitation
Failure to “pay attention” in children or “daydreaming”
Sexually acting out
Physical or verbal aggression with no trigger
Repetitive or ritualistic type behaviors that are short lived
Rapid eye blinking
Tantrums
Falls
sudden “sleep”
random talking
hard to “reach”

Behaviors Associated with
Urinary Tract Infections
►
►
►
►
►

►

New onset urinary
incontinence
Agitation
Not able to sit still
(up and down)
Repetitive trips to toilet
Screaming when
approaching toilet or with
incontinence
Grabbing genitals or
rubbing with objects

Hands in pants
Physical or verbal
aggression with no trigger
► Abdominal guarding
► Rocking
► Change in cognitive status
► Fatigue
►
►
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Behaviors associated with
Chest pain
► Scratching,

hitting or rubbing chest

► Crying
► yelling

out

► Agitation
► Anxiety
► Shortness

of breath

► Weakness

Behavior
► Consider

Behavior as a form of
communication
► Need to understand the context of the behavior
► When does it happen and when does it not
► Helps

► Are

identify what's being communicated

our expectations out of line

► “They
► “They

are not nice”
won’t do what I want them to do”

Behavior has a Function
Behaviors may persist because the person…
Enjoys the sensory experience – it feels better,
satisfies a need or impulse (internal triggers, internal
rewards)
► Escapes or avoids demands or things he or she
doesn’t like to do
► Gains attention from others
► Obtains tangible items or opportunities – access to
something he or she prefers
►

Beavers, Iwata, &Lerman, 2013
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Indications that a behavioral
pattern may be the result of a
psychiatric condition
1. The behavior occurs in all environments; it is
not just exhibited in specific settings
2. Behavioral strategies have been largely
ineffective
3. The person in service doesn’t appear to have
control over their behavior. He/she doesn’t
appear to be able to start or stop the behavior
at will.
Adapted from Mcgilvery & Sweetland, 2011

Indications that a behavioral
pattern may be the result of a
psychiatric condition
4. There are changes in sleep patterns;
increased, decreased or disturbed sleep.
5. The person in service is experiencing
excessive mood or unusual mood patterns.
6. There are changes in the person’s appearance
and a decline in their independent living skills.

Adapted from Mcgilvery & Sweetland, 2011

Indications that a behavioral
pattern may be the result of a
psychiatric condition
7. The person may start to engage in purposeful
self-harm (cutting, hitting, scratching, pulling
out hair).
8. The person may start to show signs of
hallucination, such as staring to the side or
corners and not appear to track conversations.
9. There may be changes in eating patterns such
as eating less or more.
Adapted from Mcgilvery & Sweetland, 2012

26

3/6/2019

Indications that a behavioral
pattern may be the result of a
psychiatric condition
10.The person in service has a history of a
psychiatric disorder that was in remission.
11.There is an acute onset of the behavior. If there
is a particularly rapid onset with a significant
change in mental status or cognitive
functioning, rule out a possible delirium with an
underlying medical cause.
12.There is an unusual change in behavior
patterns, such as a significant change from
baseline behavior
Adapted from Mcgilvery & Sweetland, 2012

Medical Problems
may cause significant
alterations in mood
and behavior that
mimic acute
psychiatric illness.
Charlot et al., 2011

Mental or Medical?
►

MANIA
Irritable, restless,
pacing, running back
and forth, can’t sit
still, can’t focus, can’t
get to sleep

►

AKATHISIA
Irritable, restless,
pacing, running back
and forth, can’t sit
still, can’t focus, can’t
get to sleep

►

DEPRESSION
Crying, won’t get out
of bed, decreased
concentration

►

CONSTIPATION
Crying, won’t get out
of bed, decreased
concentration

Charlot et al., 2011
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HOW CAN YOU
FACILITATE THE BEST
HEALTHCARE VISIT
FOR PEOPLE WITH IDD?

GOOD COMMUNICATION
IS THE FOUNDATION
FOR GOOD OUTCOMES

Challenges to Good Communication
Physicians have been placed in a position
where they have numerous conflicting task
priorities when they go in to see patients
► Doctors must account for every statement,
question and answer in an electronic health
record with more than 100 measures, patterns
and health outcomes being tracked by national
organizations.
► Result- face-to-face time with patients has
dropped
►
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Challenges to Good Communication
Healthcare providers likely have received little
training in the field of IDD medical care.
► People who take patients to appointments may
not have a good working understanding of
medical issues
► There is a language barrier between people with
IDD, their caregivers and the healthcare
providers
►

What can YOU do to improve
communication?
►

Be prepared for the appointment
►
►
►
►

Know your patient’s baseline
Clear, simple description of what the primary issue is
Prioritize concerns if there are multiple issues
Have any supporting documents available
►
►
►
►

►
►

►

Seizure record
Glucose record
Behavior Reports
BM report

Updates since last visit
Medications

Let the office staff know what the appointment is for and if
there is a need for extended time to accomplish goals

What can you do to improve
communication?
► Gain

an understanding of general medical
terminology
► Learn what information will help healthcare
providers the most and have it readily available
► Sharpen your skills in recognizing medical
issues in people you support

This will not only improve
communication but also improve the
health of those you support!
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What can you do to improve
communication?
►
►
►
►
►
►
►
►

Know the baseline of the patient
Have a brief summary of the persons medical history
Talk to other members of the team for their input
Know if the patient has been compliant with
medication and treatments
Ask questions about what you don’t understand
Take notes
Get written materials
Have contact information for nurse or other team
members available

What information do clinicians what
to know?
► What

is the patient’s baseline
changes have been noticed
► How long has it been going on
► How often does it occur
► What makes it start/stop
► What has been tried
► What

Before, During and
After the Visit
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Before the Visit
Take a list of specific questions to the appointment,
making sure to list the most important ones first.
► Familiarize yourself with the person’s medical history,
so you can convey it concisely to your doctor. Writing
out a brief synopsis to give a new doctor can be
helpful and save time.
► Keep a diary to track symptoms and concerns.
Convey these clearly to the doctor.
► List medications they are taking with their dosages.
Tell the doctor about any medication changes.
►

During the Visit
►
►

►
►
►

Communicate the type of home environment that
the person lives in.
Tell the provider that you are here to support the
person and to direct questions to the person if
possible.
Don’t let the person get separated from their
communication device if possible.
Tell the clinician how the person’s issues impact
their life.
Ask for clarification if you don't understand what
you have been told or if you still have questions.

During the Visit
►
►
►
►
►
►

Ask for explanations of treatment goals and side
effects.
Bring a pencil and notebook to take notes
Let your doctor know if the person is seeing other
doctors or health care providers.
Share information about any recent medical tests
or other visits.
Be an advocate the person.
Balance assertiveness with friendliness and
understanding
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After the Visit
Review all information with the patient
and the team after the visit.

Communicating a
Person’s Baseline

Determining Someone’s Baseline
► Mobility
► ADLs
► Nutrition
► Toileting
► Social
► Behavioral
► Medical
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Determining Someone’s Baseline
Mobility
► Ambulatory
► Assistance
►Type
►Frequency

► Wheelchair

use

Determining Someone’s Baseline
ADLs
► Dressing
► Meal

Preparation

► Shopping
► Money

Management

► Housekeeping
► Sleeping

Determining Someone’s Baseline
Nutrition
►

Weight
► Current
► Trend
► IBW

►
►

Type and texture of diet
Assistance needed?

►

For tube feedings

► Type
► Rate
► Type

of assistance
and time
of formula

► Reason

they are on that type

► Volume

issues?
► Recent change and reason?
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Determining Someone’s Baseline
Toileting
► Continent
► Prompting
► Assistance
► Routine

pattern
issues
► LAST BM
► Constipation

Determining Someone’s Baseline
Social
► Usual

responses to various stimuli

► Likes
► Dislikes
► Happy
► Sad
► Angry
► Aggression
► Pain

► Interaction

with others

► Recreation

Determining Someone’s Baseline
Social
► Verbalization
► Orientation
► Awareness
► Reliability

► How

they normally communicate
(communication device)
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Determining Someone’s Baseline
Behavioral
► Aggression
► Toward

others

► SIB

► PICA
► Inappropriate,

non-aggressive behavior
aggression
► Yelling/screaming
► Sexual

Determining Someone’s Baseline
Medical
► Fear

of medical community?
Problems

► Medical
► Big

List

► Current

► Taking

issues

medication

► Route
► Mixed

with food or drink

► Pills/Liquids/Other
► Take

on their own or needs assistance

Determining Someone’s Baseline
► Mobility
► ADLs
► Nutrition
► Toileting
► Social
► Behavioral
► Medical
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Most Common Chief Complaints
► “He’s

just not acting right”
quit eating”

► “She’s

Communicating the Baseline &
Changes
Examples
► 45 y/o male who usually walks with a mild limp,
feeds and dresses himself, Loves to watch
baseball, does not like loud noises which cause
him to cover his ears, scream and run away
► He is now getting up very slowly, he doesn’t want
to watch baseball. We have to put the spoon to his
mouth and hold his cup to his lips and he is still not
taking it very well. Now when he hears loud noises
he will just sit there and moan. He puts his head in
his hands most of the time now, as well.
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Communicating the Baseline &
Changes
Examples
► 24 y/o female who uses a wheelchair, can transfer to
a chair with assistance of one person, eats a puree
diet because of poor dentition, not verbal but
grimaces at things she dislikes and smiles at things
she likes. She hits her leg whenever she becomes
angry or is in pain from anything
► For the past 2 weeks, she no longer can transfer and
fell twice while trying, she seems to have a hard time
swallowing and coughs sometimes when she eats,
she is not smiling when she sees me (who is her
favorite staff of all time), she hits her leg all
throughout the day.

Diabetes
► Bring written glucose
► Know if the person is

record.
urinating more frequently
► Know dietary information
► Know exercise information
► Note if there have been any symptoms of
hypoglycemia
► Shaking
► Confusion
► Sweatiness
► Seizures

► Medication

compliance

Hypertension – High Blood Pressure
► Diet

information
intake
► Exercise
► Bring record of blood pressure
readings with date and time
► Medication compliance
► Salt
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Seizures
► Bring

accurate seizure record

► How often seizures occur
► Length of seizures
► What the seizure looks like
► How long they last

► Know

if there is anything that brings them on
is the person after the seizure (post-ictal
period)
► Is there a change in pattern of the seizure or the
period after
► Medication compliance
► How

GI - Bowel Habits
► How

often
were the last 2-3 BMs
► Consistency
► Any episodes of constipation or diarrhea
► Vomiting episodes
► Water consumption
► Swallowing issues
► Choking spells
► PEG feedings
► When
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Respiratory issues
► Fever
► Cough
► Night Sweats
► Weight loss
► Wheezing
► Shortness

of breath
phlegm

► Coughing up
► Runny nose

► Sore throat
► Vomiting episodes
► Swallowing/Choking

issues

Injuries
► When

did it occur
or not
► Have name and contact info of
person who saw it
► Symptoms (limp, not using hand,
swollen finger etc.)
► What is the person’s baseline level
of functioning of the injured part
► Witnessed

Urinary Issues
► How

often does the person urinate

► Any

change in frequency

► Usual

color of urine
complaints of pain with
urination in genitalia, stomach or
back
► Straining
► Poor stream
► Sexual activity
► Any
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Behavioral issues
► COULD

THERE BE ANY POSSIBLE
UNDERLYING MEDICAL CAUSE?
► When does it occur
► Things that start or stop the behavior
► How long has it been going on

QUESTIONS
► What

are the top preventable causes of
death in people with IDD?
► How can you distinguish between
medical and mental conditions in
people with IDD?
► How can you facilitate the best
healthcare visit for people with IDD?

DID YOU LEARN ANYTHING
HELPFUL TODAY?
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PUT IT TO GOOD USE!!!!!!!!

THANK YOU
For What You Do!

Craig Escudé, MD, FAAFP
Craig@HRSTonline.com
HRSTonline.com
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